Legal Notices

This guide is copyrighted ©2010 by Avid Technology, Inc., (hereafter “Avid”), with all rights reserved. Under copyright laws, this guide may not be duplicated in whole or in part without the written consent of Avid.

Guide Part Number 9320-65003-00 REV C 11/10

Documentation Feedback

At Avid, we are always looking for ways to improve our documentation. If you have comments, corrections, or suggestions regarding our documentation, email us at techpubs@avid.com.
Chapter 1. Welcome to Pro Tools|HD Native .................................................. 1
  Pro Tools|HD Native Package ............................................................. 1
  Pro Tools|HD Native Systems ............................................................... 1
  Pro Tools|HD Native Capabilities .......................................................... 2
  System Requirements and Compatibility ............................................... 2
  Registration ...................................................................................... 3
  Conventions Used in This Guide ......................................................... 4
  About www.avid.com ......................................................................... 4

Chapter 2. Pro Tools|HD Native Hardware Overview ................................. 5
  Pro Tools|HD Native PCIe Card ............................................................. 5
  DigiLink Mini and DigiLink Cables ...................................................... 6
  Audio Interfaces .................................................................................. 7
  Additional Hardware Options ............................................................. 12

Chapter 3. Installing Pro Tools Hardware ............................................... 13
  Installing Pro Tools|HD Native Card in a Mac Pro .................................. 13
  Installing Pro Tools|HD Native Card in a Windows Computer ................. 15
  Connecting Audio Interfaces ............................................................... 16
  Installing and Authorizing Pro Tools HD Software ................................ 18
  Configuring Your Pro Tools System .................................................... 18

Appendix A. Configuring CoreAudio (Mac OS X Only) ......................... 19
  CoreAudio Driver Capabilities ........................................................... 19
  Installing the CoreAudio Driver ......................................................... 19
  CoreAudio Manager .......................................................................... 20
  Configuring a Pro Tools|HD Audio Interface for Third-Party Applications 23
  Configuring the Apple Sound Preferences or Apple Audio MIDI Setup 23
Appendix B. Configuring ASIO (Windows Only) ............................................. 25
  ASIO Driver Capabilities ................................................................. 25
  Installing the ASIO Driver ............................................................. 25
  ASIO Driver Control Panel ............................................................. 26

Appendix C. Low Latency Monitoring ......................................................... 29
  Using Low Latency Monitoring ........................................................ 29
  Configuring Low Latency Monitoring in the I/O Setup ......................... 30
  Low Latency Monitoring and Bounce To Disk ................................... 30

Appendix D. System Delays in Mixing ....................................................... 31
  Introduction to System Delay .......................................................... 31
  Using Delay Compensation ............................................................ 32
  Delay Factors .................................................................................. 32

Appendix E. Troubleshooting ................................................................. 33
  Backing Up Your Work .................................................................... 33
  Common Issues ............................................................................... 34
  Using DigiTest as a Diagnostic Tool ............................................... 35
  Performance Factors ....................................................................... 38
  Before You Call Avid ....................................................................... 38

Appendix F. Compliance Information ....................................................... 41
  Environmental Compliance .............................................................. 41
  EMC (Electromagnetic Compliance) .................................................. 42
  Safety Compliance .......................................................................... 43

Index .................................................................................................. 45
Chapter 1: Welcome to Pro Tools|HD Native

Pro Tools®|HD Native provides high-definition digital audio recording, editing, signal processing, mixing, and I/O capabilities.

This guide covers installation of Pro Tools|HD Native hardware on Mac and Windows platforms. For information about installing Pro Tools software, see the Pro Tools Installation Guide included with your Pro Tools software package.

Pro Tools|HD Native Package

The Pro Tools|HD Native package includes the following:

- Pro Tools|HD Native PCIe card
- 12’ DigiLink™ Mini cable for connecting the Pro Tools|HD Native card to an audio interface
- DigiLink Mini to DigiLink adapter cable
- Pro Tools Software Installer package
- An iLok USB key
- An Activation Card with an Activation code for a Pro Tools HD license
- Registration Information Card
- This User Guide, covering installation and configuration of Pro Tools|HD Native
- Pro Tools|HD Native Quick Setup, covering basic hardware installation
- Health and Safety Guide

Pro Tools|HD Native Systems

All Pro Tools|HD Native systems consist of the following:

- Pro Tools HD software
- Pro Tools|HD Native PCIe card
- At least one (up to four) of the following Pro Tools|HD audio interfaces:
  - HD OMNI
  - HD I/O
  - HD MADI
  - 192 I/O™
  - 192 Digital I/O™
  - 96 I/O™
  - 96i I/O™

⚠️ Only one HD OMNI can be used in a single Pro Tools|HD Native system.

⚠️ Only one HD MADI can be used in a single Pro Tools|HD Native system.
Pro Tools|HD Native Capabilities

Pro Tools HD running on Pro Tools|HD Native hardware provides the following capabilities:

- Up to 64 channels of I/O depending on your system and the number of audio interfaces
- Up to a total of 192 voiced audio tracks (up to 512 voiceable audio tracks):
  - Up to 192 tracks at 44.1 kHz or 48 kHz
  - Up to 96 tracks at 88.2 kHz or 96 kHz
  - Up to 48 tracks at 176.4 kHz or 192 kHz
- Up to 160 Auxiliary Input tracks
- Up to 64 Master Fader tracks
- Up to 128 VCA Master tracks
- Up to 512 MIDI tracks
- Up to 128 Instrument tracks
- Up to 64 video tracks per session
- 16-bit or 24-bit audio resolution, at sample rates up to 192 kHz
- Up to 7.1 surround mixing capability
- Automatic Delay Compensation
- Low Latency Monitoring
- Non-destructive, random-access editing and mix automation
- Audio processing with up to 10 TDM or RTAS plug-ins per track, depending on your computer’s capabilities
- Up to 10 hardware inserts per track
- Up to 10 sends per track
- Up to 256 internal mix busses for routing and mixing

For detailed information about Pro Tools software functionality, see the Pro Tools Reference Guide (Help > Pro Tools Reference Guide).

System Requirements and Compatibility

Pro Tools|HD Native can be used with a qualified Mac or Windows computer running Pro Tools HD software.

A DVD drive is required to use the Pro Tools Installer disc.

Avid can only assure compatibility and provide support for hardware and software it has tested and approved.

For complete system requirements and a list of qualified computers, operating systems, hard drives, and third-party devices, refer to the latest information on our website: www.avid.com/compatibility

iLok USB Key Authorization

Pro Tools|HD Native systems include an iLok USB key and an Activation code (on the included Activation card) for your Pro Tools HD software.

An authorized iLok must be inserted in an available USB port on your computer to run Pro Tools.

Pro Tools software is authorized using the iLok USB Smart Key (iLok) from PACE Anti-Piracy.

For detailed information about Pro Tools software functionality, see the Pro Tools Reference Guide (Help > Pro Tools Reference Guide).
An iLok can hold hundreds authorizations for all of your iLok-enabled software. Once an iLok is authorized for a given piece of software, you can use the iLok to authorize that software on any computer.

⚠️ An authorized iLok must be inserted in an available USB port on your computer to run Pro Tools HD.

For information about installing and authorizing your Pro Tools HD software, see the printed Pro Tools Installation Guide included with your Pro Tools Software Package.

### MIDI Requirements

USB MIDI interfaces (such as the M-Audio MIDI-SPORT series) and USB MIDI controllers (such as the M-Audio Axiom Pro series) work effectively with Pro Tools systems on Windows or Mac.

For a list of supported MIDI interfaces and controllers, refer to our website (www.avid.com).

### Hard Drive Requirements

For optimal audio recording and playback, Pro Tools|HD Native systems require one or more qualified hard drives.

Initialize your hard drives with the Disk Utility application included with Apple System software (Mac) or using Windows Disk Management (Windows).

### Avoid Recording to the System Drive

Recording to your system drive is not recommended. Recording and playback on a system drive may result in lower track counts and fewer plug-ins.

💡 If you have multiple hard drives in your system, use DigiBase to designate the system drive as a Playback or Transfer only drive for optimal performance. For more information about using DigiBase, see the Pro Tools Reference Guide.

### Registration

Review the enclosed Registration Information Card and follow the instructions on it to quickly register your purchase online. This is one of the most important steps you can take as a new user. Registering your purchase is the only way you can be eligible to receive:

- Information regarding technical support
- Future upgrade offers
- Limited warranty on hardware
Conventions Used in This Guide

All Pro Tools guides use the following conventions to indicate menu choices and key commands:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Save</td>
<td>Choose Save from the File menu</td>
</tr>
<tr>
<td>Control+N</td>
<td>Hold down the Control key and press the N key</td>
</tr>
<tr>
<td>Control-click</td>
<td>Hold down the Control key and click the mouse button</td>
</tr>
<tr>
<td>Right-click</td>
<td>Click with the right mouse button</td>
</tr>
</tbody>
</table>

The names of Commands, Options, and Settings that appear on-screen are in a different font.

The following symbols are used to highlight important information:

💡 **User Tips** are helpful hints for getting the most from your Pro Tools system.

⚠️ **Important Notices** include information that could affect your Pro Tools session data or the performance of your Pro Tools system.

✍️ **Shortcuts** show you useful keyboard or mouse shortcuts.

📖 **Cross References** point to related sections in the Pro Tools Guides.

About www.avid.com

The Avid website (www.avid.com) is your best online source for information to help you get the most out of your Pro Tools system. The following are just a few of the services and features available.

**Product Registration** Register your purchase online.

**Support and Downloads** Contact Avid Customer Success (technical support); download software updates and the latest online manuals; browse the Compatibility documents for system requirements; search the online Knowledge Base or join the worldwide Pro Tools community on the User Conference.

**Training and Education** Study on your own using courses available online or find out how you can learn in a classroom setting at a certified Pro Tools training center.

**Products and Developers** Learn about Avid products; download demo software or learn about our Development Partners and their plug-ins, applications, and hardware.

**News and Events** Get the latest news from Avid or sign up for a Pro Tools demo.

**Pro Tools Accelerated Videos** Watch the series of free tutorial videos. Accelerated Videos are designed to help you get up and running with Pro Tools and its plug-ins quickly.
This section describes each hardware component of a Pro Tools|HD Native system.

**Pro Tools|HD Native PCIe Card**

The Pro Tools|HD Native PCIe card supports up to 64 channels of I/O for direct-to-disk recording and playback (up to 192 tracks with Pro Tools HD software), and supports up to 24-bit and up to 192 kHz sessions. Additionally, the on-board FPGA provides processing power for mixer configurations and low latency monitoring with Pro Tools.

**DigiLink Mini Ports**

The Pro Tools|HD Native PCIe card includes two DigiLink Mini ports for connecting up to 32 channels of audio input and output each to your Pro Tools system.

**DigiSerial Port**

The DigiSerial port on the Pro Tools|HD Native PCIe card is for connecting a SYNC peripheral. This connector is an 8-pin mini-DIN.

⚠️ *The DigiSerial port on a Pro Tools|HD Native PCIe card does not support Machine-Control connections.*
**DigiLink Mini and DigiLink Cables**

Use DigiLink cables to connect 192 I/O, 192 Digital I/O, 96 I/O, and 96i I/O audio interfaces to Pro Tools|HD cards. Use DigiLink cables with a DigiLink to DigiLink Mini adapter cable to connect HD I/O, HD OMNI, and HD MADI audio interfaces to Pro Tools|HD cards.

**DigiLink Cable Length Specifications**

There are six different lengths of DigiLink cables:

- 18” (0.46m), included with 192 I/O, 192 Digital I/O, 96 I/O, and 96i I/O
- 12’ (3.6m) (included with Pro Tools|HD cards)
- 25’ (7.62m) (sold separately)
- 50’ (15.25m), the maximum length supported for 176.4 kHz and 192 kHz sessions (sold separately)
- 100’ (30.5m), the maximum length supported by 88.2 kHz and 96 kHz sessions (sold separately)

**DigiLink to DigiLink Mini Adapter Cables**

Use DigiLink to DigiLink Mini adapter cables to connect HD I/O, HD OMNI, and HD MADI to Pro Tools|HD cards. You can also use DigiLink to DigiLink Mini adapter cables to connect older HD peripherals (such as 192 I/O) to the Expansion port of HD I/O and HD OMNI.

There are two types of DigiLink to DigiLink Mini adapter cables:

- 12” DigiLink female to DigiLink Mini male, included with each interface
- 12” DigiLink Mini female to DigiLink male

**DigiLink Mini Cable Length Specifications**

There are six different lengths of DigiLink Mini cables:

- 18” (0.46m), included with HD I/O, HD OMNI, and HD MADI
- 12’ (3.6m) (sold separately)
- 25’ (7.62m) (sold separately)
- 50’ (15.25m), the maximum length supported for 176.4 kHz and 192 kHz sessions (sold separately)
- 100’ (30.5m), the maximum length supported by 88.2 kHz and 96 kHz sessions (sold separately)

*For more information about DigiLink Mini and DigiLink Mini to DigiLink cables, visit the Avid website (www.avid.com).*
Audio Interfaces

To record and play audio with Pro Tools HD, you must have at least one Pro Tools|HD audio interface connected to the Pro Tools|HD Native card. Pro Tools|HD Native systems support up to 4 Pro Tools|HD audio interfaces for up to 64 simultaneous channels of input and output.

⚠️ Pro Tools|HD Native systems do not support legacy Pro Tools|24 MIX™ audio interfaces (such as the 888|24 or 882|20).

HD OMNI

HD OMNI is a professional digital audio interface designed for use with Pro Tools|HD and Pro Tools|HD Native systems. HD OMNI provides a compact preamp, monitoring, and I/O solution for music production and recording, and post production studios.

⚠️ Only one HD OMNI can be used in a single Pro Tools|HD Native system.

HD OMNI Features

HD OMNI provides up to 8 discrete channels of Pro Tools input and output, with 4-segment LED meters for input or output (selectable).

Analogue I/O

- 24-bit analog-to-digital (A/D) and digital-to-analog (D/A) converters, with support for sample rates up to 192 kHz
- 2 high-quality Mic/DI preamps (Channels 1–2)
- 2 combined XLR and 1/4-inch TRS front panel inputs for microphone and instrument level input
- 2 XLR back panel microphone inputs
- 2 1/4-inch TRS Send and 2 1/4-inch TRS Return back panel jacks for hardware inserts on channels 1 and 2
- 4 analog TRS line level back panel inputs (Channels 1–4)

⚠️ HD OMNI provides multiple analog input connections, but only provides up to four channels of simultaneous analog input.

- Soft Clip and Curv limiting circuits to protect against clipping on analog input
- 8 channels of analog back panel output using a DB-25 breakout cable (sold separately) with variable output gain
- 2 channels of analog back panel output using TRS (Mirrors channels 1–2 or 7–8 on DB-25 connector)
- Front panel stereo 1/4” headphone jack

Digital I/O

- 8 channels of AES/EBU output (up to 192 kHz Single Wire) using a DB-25 breakout cable (sold separately)
- 2 channels of AES/EBU XLR input (up to 192 kHz Single Wire)
- 2 channels of S/PDIF RCA input and output (up to 192 kHz)
- 8 channels of ADAT TOSLINK input and output
- Support for ADAT S/MUX Optical for sample rates of 88.2 kHz, 96 kHz, 176.4 kHz, and 192 kHz
- Support for two channels of S/PDIF Optical with sample rates of up to 96 kHz
- Real-time sample rate conversion (SRC) on Digital Inputs 1–2 of either AES/EBU, S/PDIF, or Optical (S/PDIF)

⚠️ SRC is not supported with ADAT S/MUX.
**Monitoring**

- An additional stereo “CUE” output path in Pro Tools for headphone monitoring from the front panel headphone jack
- Front panel Control Room (MAIN/ALT) and Headphone monitoring volume control
- Flexible monitoring with fold-down from all stereo and surround formats (up to 7.1 surround)
- Input mixer for low latency direct monitoring of a variety of incoming signals (configured in the Pro Tools Hardware Setup)

**Synchronization**

- Loop Sync input and output for connecting additional Pro Tools|HD interfaces and peripherals
- External Clock input and output for synchronizing HD OMNI with external Word Clock devices

For more information about HD OMNI, see the HD OMNI Guide.

**HD I/O**

HD I/O is a multichannel digital audio interface designed for use with Pro Tools|HD and Pro Tools|HD Native systems. HD I/O features extremely high quality 24-bit analog-to-digital (A/D) and digital-to-analog (D/A) converters, and supports sample rates of up to 192 kHz.

HD I/O comes in three standard configurations:

- 8 x 8 x 8 (8 analog in, 8 analog out, and 8 digital in and out)
- 16 x 16 analog in and out
- 16 x 16 digital in and out

You can also add or remove HD I/O Analog Expansion cards (ADC and DAC) and HD I/O Digital Expansion cards for custom configurations.

**HD I/O Features**

HD I/O provides up to 16 discrete channels of Pro Tools input and output, with 4-segment LED meters for input and output.

**Analog I/O**

- Up to sixteen channels of 24-bit D/A and A/D converters for superior analog input and output at sample rates of 44.1 kHz, 48 kHz, 88.2 kHz, 96 kHz, 176.4 kHz, and 192 kHz with Analog In and Analog Out HD I/O cards
- Soft Clip and Curv limiting circuits to protect against clipping on analog input
Digital I/O

- Up to sixteen channels of 24-bit digital I/O, using AES/EBU, TDIF DB-25, or Optical at sample rates of 44.1 kHz, 48 kHz, 88.2 kHz, 96 kHz, 176.4 kHz, and 192 kHz with a Digital HD I/O card
- Real-time sample rate conversion on digital inputs with a Digital I/O card (up to sixteen channels of AES/EBU, Optical, or TDIF)
- Support for S/MUX Optical for sample rates of 88.2 kHz and higher
- Support for 2 channels of S/PDIF Optical (enclosed) with sample rates of up to 96 kHz
- 2 channels of AES/EBU I/O (enclosed) with support for sample rates up to 192 kHz
- 2 channels of 24-bit-capable S/PDIF I/O (enclosed) with support for sample rates up to 192 kHz

Synchronization

- Loop Sync input and output for connecting additional Pro Tools|HD interfaces and peripherals
- External Clock input and output for synchronizing HD I/O with external Word Clock devices

Expandability

- Optional addition of I/O cards to expand analog or digital I/O
- Simultaneous use of multiple Pro Tools|HD audio interfaces to further expand system input and output (for more information see the Expanded Systems Guide)

For more information about HD I/O, see the HD I/O Guide.

HD MADI

HD MADI is a 64-channel, digital audio interface designed for use with Pro Tools|HD and Pro Tools|HD Native systems. HD MADI supports the Multichannel Audio Digital Interface (MADI) format and sample rates of up to 192 kHz. HD MADI provides simplified connectivity between your Pro Tools|HD or Pro Tools|HD Native system and MADI-compatible audio equipment, such as routers, digital mixing consoles, and converters.

To use the full channel capacity of HD MADI, only a single HD MADI can be connected to a Pro Tools|HD Native card using two DigiLink Mini cables. No additional I/O may be used with this configuration.

HD MADI Features

- 2 MADI Optical and Coaxial inputs and 2 MADI Optical and Coaxial outputs for up to 64 discrete channels of digital input and output (32 channels per DigiLink Mini port)
- Supports sample rates of 44.1 kHz, 48 kHz, 88.2 kHz, 96 kHz, 176.4 kHz, and 192 kHz
- 24- or 16-bit resolution
- Sample Rate Conversion (SRC) on input or output
- Front panel clock and SRC indicators
- Front panel signal present LEDs for input and output
- BNC Word Clock I/O for synchronizing HD MADI with external 1x Word Clock
- BNC Loop Sync I/O for synchronizing HD MADI with additional Pro Tools|HD audio interfaces and peripherals (such as HD I/O, HD OMNI, or SYNC HD)
• Dedicated BNC Word Clock input and XLR AES/EBU input (clock input only) for external MADI synchronization (when using SRC on output)
• Clock support for the following formats: Internal, Loop Sync, Word Clock, AES/EBU, and MADI
• Varispeed modes (supports both 64- and 56-channel standards)

For more information about HD MADI, see the HD MADI Guide.

192 I/O Audio Interface

192 I/O is a multichannel digital audio interface designed for use with Pro Tools|HD systems. 192 I/O features high quality 24-bit analog-to-digital (A/D) and digital-to-analog (D/A) converters, and supports sample rates of up to 192 kHz.

You can also add or remove analog cards (ADC and DAC) and digital cards for custom configurations.

A DigiLink to DigiLink Mini adapter cable is required to connect 192 I/O to the Pro Tools|HD Native card.

192 I/O Features

• Supports sample rates up to 192 kHz
• Supports both analog and digital connections, including AES/EBU, S/PDIF, TDIF, and ADAT Optical:
  • Digital (Digital I/O Card): 8 channels, DB-25 (AES/EBU and TDIF), or one pair of Lightpipe (ADAT Optical) connectors; Expandable up to 16 of channels digital I/O with the addition of the 192 Digital expansion card
  • Analog: 8 channels, DB-25 (balanced) connectors, inputs selectable between +4 dBu or –10 dBV, outputs +4 dBu only; Expandable up to 16 analog inputs or 16 outputs using an optional 192 AD or 192 DA expansion card, respectively
  • Digital (Enclosure): 2 channels, XLR (AES/EBU) connectors; 2 channels RCA (S/PDIF) connectors
  • Optical (Enclosure): 8 channels, one pair of Lightpipe (ADAT Optical) connectors (switchable to 2 channels, S/PDIF)
• Loop Sync In and Out for connecting Pro Tools|HD interfaces and peripherals
• External Clock In and Out receive or send 1x Word clock

For more information, see the 192 I/O Guide.
192 Digital I/O Audio Interface

192 Digital I/O is a multichannel digital audio interface designed for use with Pro Tools|HD systems, and supports sample rates of up to 192 kHz.

⚠️ *A DigiLink to DigiLink Mini adapter cable is required to connect 192 Digital I/O to the Pro Tools|HD Native card.*

192 Digital I/O Features

- Supports sample rates up to 192 kHz
- Supports digital connections, including AES/EBU, S/PDIF, TDIF, and ADAT Optical:
  - Digital (2 Digital I/O Cards): 16 channels, DB-25 (AES/EBU and TDIF), or two pairs of Lightpipe (ADAT Optical) connectors
  - Digital (Enclosure): 2 channels, XLR (AES/EBU) connectors; 2 channels RCA (S/PDIF) connectors
  - Optical (Enclosure): 8 channels, one pair of Lightpipe (ADAT Optical) connectors (selectable to 2 channels, S/PDIF)
- Loop Sync In and Out for connecting Pro Tools|HD interfaces and peripherals
- External Clock In and Out receive or send 1x Word clock

⚠️ *For more information, see the 192 Digital I/O Guide.*

96 I/O Audio Interface

96 I/O is a multichannel digital audio interface designed for use with Pro Tools|HD systems. 96 I/O features high quality 24-bit analog-to-digital (A/D) and digital-to-analog (D/A) converters, and supports sample rates of up to 96 kHz.

⚠️ *A DigiLink to DigiLink Mini adapter cable is required to connect 96 I/O to the Pro Tools|HD Native card.*

96 I/O Features

- Supports sample rates up to 96 kHz
- Supports analog and digital connections, including AES/EBU, S/PDIF, and ADAT optical:
  - Analog: 8 channels, 1/4-inch TRS (balanced or unbalanced) connectors, +4 dBu or –10 dBV
  - Digital: 2 channels, XLR (AES/EBU) connectors; 2 channels, RCA (S/PDIF) connectors
  - Optical: 8 channels, one pair of Lightpipe (ADAT Optical) connectors (switchable to 2 channels, S/PDIF)
- External Clock In and Out receive or send 1x Word clock

⚠️ *For more information, see the 96 I/O Guide.*
96i I/O Audio Interface

96i I/O is a multichannel digital audio interface designed for use with Pro Tools|HD systems. 96i I/O features high quality 24-bit analog-to-digital (A/D) and digital-to-analog (D/A) converters, and supports sample rates of up to 96 kHz.

⚠️ A DigiLink to DigiLink Mini adapter cable is required to connect 96i I/O to the Pro Tools|HD Native card.

96i I/O Features

- Supports sample rates up to 96 kHz
- 16 discrete channels of input, and 2 channels of output, with 4-segment LED meters on each channel. Audio inputs and outputs include:
  - 16 channels of 24-bit, 96-kHz capable analog input, with adjustable input sensitivity
  - 2 channels of 24-bit, 96-kHz capable analog output, with selectable operating level
  - 2 channels of 24-bit, 96 kHz-capable digital S/PDIF RCA input and output
- Loop Sync In and Out for connecting Pro Tools|HD interfaces and peripherals
- External Clock In and Out receive or send 1x Word clock

⚠️ For more information, see the 96i I/O Guide.

Additional Hardware Options

Pro Tools|HD Native systems also support the following Pro Tools hardware options:

- SYNC HD™
- SYNC I/O™
- PRE™
- MIDI I/O
- Worksurfaces and control surfaces:
  - D-Control™
  - D-Command®
  - C|24™
  - Command|8®
  - EUCON™-compatible control surfaces

A DigiLink to DigiLink Mini adapter cable is required to connect 96i I/O to the Pro Tools|HD Native card.

For more information, see the 96i I/O Guide.
Installing Pro Tools Hardware

This chapter provides information on installing and connecting the Pro Tools|HD Native card and Pro Tools|HD audio interfaces. Install your Pro Tools|HD hardware before installing Pro Tools HD software.

To install Pro Tools|HD hardware, first install the Pro Tools|HD Native card. Once the card is installed, connect Pro Tools|HD audio interfaces.

Installing Pro Tools|HD Native Card in a Mac Pro

The Pro Tools|HD Native card is a 4x PCIe card. For optimum performance, install the Pro Tools|HD Native card in a 4x or higher PCIe card slot in your computer.

⚠️ If you are installing the Pro Tools|HD Native card in the slot furthest from the video card, you may need to remove the SATA drive trays first to avoid damaging the card when installing it.

⚠️ Pro Tools|HD Native is supported with Mac Pro only. PowerPC Macs are not supported.

Figure 1. Mac Pro

Follow these instructions carefully to avoid damaging the card and its components.
To install the Pro Tools|HD Native card:

1. Turn off your computer and any peripherals. Leave your computer’s power cable plugged in so that the computer is grounded.

2. Disconnect all cables attached to the computer (such as hard drives, displays, and USB and FireWire devices) except for the power cable.

3. Lay the computer on its side so the access panel is facing up.

4. Open the computer case using the latch located on the back of the computer.

5. Remove the clamp that secures the metal access port covers to the chassis.

6. Remove the metal access port covers for first available 4x or higher PCIe slot.

⚠️ Before handling the card, discharge static electricity from your clothes or body by touching a grounded metal surface, such as the power supply case inside your computer with the power cable connected.

7. Install the Pro Tools|HD Native PCIe card into the corresponding PCIe slot in the computer. With the card’s PCIe connectors facing down, carefully insert the card straight down and firmly seat the card’s PCIe connector into the PCIe slot.

8. Ensure that any additional cards are properly installed in your system:
   - Display card for your computer monitor
   - Pro Tools|HD Native PCIe card
   - Avid-approved video capture card (optional)
   - Avid-approved Host-Bus Adapter card (optional)

9. Reattach the clamp that secures the cards and the slot covers to the chassis.

⚠️ The card’s PCIe connectors will not seat completely until you have replaced the clamp that secures the cards and the metal access port covers to the chassis.
Installing Pro Tools|HD Native Card in a Windows Computer

The Pro Tools|HD Native card is a 4x PCIe card. For optimum performance, install the Pro Tools|HD Native card in a 4x or higher PCIe card slot in your computer.

To install the Pro Tools|HD Native card:

1. Turn off your computer and any peripherals. Leave your computer’s power cable plugged in so the computer is grounded.

2. Disconnect all cables attached to the computer (such as hard drives, displays, and USB and FireWire devices) except for the power cable.

3. Open the computer case.

4. Remove the metal access port cover behind the first available 4x or higher PCIe card slot (typically, this will be the slot right next to the video card) by removing the screw and sliding the cover out from the access port.

5. Install the Pro Tools|HD Native card in the corresponding PCIe slot.

6. Secure the card in place with the slot access port screw you removed earlier.

7. Ensure that any additional cards are properly installed for your system:
   - Display card for your computer monitor
   - Pro Tools|HD Native card (for PCIe)
   - Avid-approved Host-Bus Adapter card (optional)

Before handling any card, discharge static electricity from your clothes or body by touching a grounded metal surface, such as the power supply case inside your computer.
Connecting Audio Interfaces

Each Pro Tools|HD audio interface provides several different input and output options. For example, HD OMNI supplies up to 8 channels of input and output to your Pro Tools system, HD I/O supplies up to 16 channels of input and output, and HD MADI provides up to 64 channels. Audio interfaces can be connected directly to the Pro Tools|HD Native card, or through the Expansion ports on other Pro Tools|HD audio interfaces.

The Pro Tools|HD Native card supports up to 64 channels of audio input and output. To get a full 64 channels of I/O, you can connect up to four 16-channel Pro Tools|HD audio interfaces to the Pro Tools|HD Native card. Two of the interfaces connect directly to DigiLink Mini Ports 1 and 2, and the other 2 interfaces connect to the Expansion ports on those Pro Tools|HD audio interfaces.

You can also get a full 64 channels of I/O with HD MADI connected to the Pro Tools|HD Native card using 2 DigiLink Mini cables. However, HD MADI will be the only audio interface in the system.

At least one Pro Tools|HD audio interface must be connected to the Pro Tools|HD Core card for Pro Tools to launch.

To connect Pro Tools audio interfaces:

1. If you are using a single Pro Tools|HD audio interface (such as HD OMNI), connect the Primary Port to DigiLink Mini Port 1 on the Pro Tools|HD Native card with the included DigiLink Mini cable. You must attach at least one Pro Tools|HD audio interface to your system in order for Pro Tools to launch.

2. Connect an additional Pro Tools audio interface by doing one of the following:

   - Connect the Primary Port of the secondary interface to the Expansion Port of the primary interface with an additional DigiLink Mini (or DigiLink Mini to DigiLink cable).
   - Connect the Primary Port of the secondary interface to DigiLink Mini Port 2 on the Pro Tools|HD Native card.

3. Make the necessary Loop Sync connections.


- Front and back panel connectors and indicators
- Installation of optional expansion I/O cards (HD I/O and 192 I/O only)
Connecting Loop Sync

If you are using two (or more) Pro Tools audio interfaces or a SYNC peripheral, Loop Sync must be connected to maintain proper clock among the devices.

To make Loop Sync connections:

1. Connect the Loop Sync Out of each interface to the Loop Sync In of the next interface with the BNC cables included in your I/O packaging.

2. Connect the Loop Sync Out of the last interface to the Loop Sync In of the primary interface or SYNC peripheral.

Figure 2. Making DigiLink Mini and Loop Sync connections
Maximum I/O Configuration

Pro Tools|HD Native supports up to a maximum combination of up to four total of the following audio interfaces:

- HD OMNI (only one HD OMNI is supported in a single Pro Tools|HD system)
- HD I/O (up to four HD I/O can be used simultaneously)
- HD MADI (full connectivity with one HD MADI is possible when both DigiLink ports of the HD MADI are connected to both DigiLink ports on the Pro Tools|HD Native card)
- 192 I/O (up to four 192 I/O can be used simultaneously)
- 192 Digital I/O (up to four 192 Digital I/O can be used simultaneously)
- 96 I/O (up to four 96 I/O can be used simultaneously)
- 96i I/O (up to two 96i I/O can be used simultaneously)

For an example of connecting multiple Pro Tools|HD audio interfaces, see Figure 2 on page 17.

⚠️ Pro Tools|HD audio interfaces need room at their sides to maintain proper air flow for cooling. Do not block the sides of the unit or disconnect the internal fan. If the units are rack-mounted in a case, remove the case lids or doors before operating the system. Failure to do so can result in the units overheating very quickly, which can permanently damage sensitive components.

Installing and Authorizing Pro Tools HD Software

Once you have installed your Pro Tools|HD Native hardware in your computer, you can install and authorize your Pro Tools HD software.

For complete installation and authorization instructions, see the Pro Tools Installation Guide that came with your Pro Tools Software package.

Configuring Your Pro Tools System

After you have installed, authorized, and launched Pro Tools software, you can configure your Pro Tools system to meet the specific needs of your studio. For detailed information on configuring your Pro Tools software, see the Pro Tools Reference Guide (which is available from the Help menu in Pro Tools).
appendix a

Configuring CoreAudio (Mac OS X Only)

CoreAudio Driver Capabilities

The CoreAudio Driver is a multi-client, multi-channel sound driver that lets CoreAudio–compatible applications record and play back through Pro Tools hardware.

Full-duplex recording and playback of 24-bit audio is supported at sample rates up to 96 kHz, depending on your Pro Tools hardware and CoreAudio client application.

The Pro Tools CoreAudio Driver provides up to 64 channels of I/O with Pro Tools|HD Native systems.

💡 Visit www.avid.com for the latest CoreAudio drivers for Pro Tools hardware, as well as current known issues.

Limitations of the CoreAudio Driver

The CoreAudio Driver has the following limitations:

♦ The CoreAudio Driver cannot be used to preview sound files from the Mac Finder. When a sound file is located in the Mac OS X navigation window, a QuickTime transport bar is displayed next to it. The QuickTime transport bar lets you audition the sound file. The sound will always play back through the Mac’s built-in audio controller (through the Mac speaker or headphone jack). However, if you double-click a sound file, the QuickTime application will launch, and can use the CoreAudio Driver for playback.

♦ The CoreAudio Driver cannot be used for playback of Mac System Sounds.

Installing the CoreAudio Driver

The CoreAudio Driver is installed by default when you install Pro Tools.

The CoreAudio Driver can also be installed as a standalone driver on Mac systems that do not have Pro Tools software installed. The installer for the standalone CoreAudio Driver is available on the Drivers Installer disc that came with your Pro Tools Software package, or from our website (www.avid.com).

⚠️ If you uninstall Pro Tools, the CoreAudio Driver is automatically uninstalled at that time.
To install the standalone CoreAudio Driver:

1. Ensure that your Pro Tools|HD Native hardware is correctly installed.

2. Do one of the following:
   - Insert the Driver Installers Disc that came with your Pro Tools Software package in your computer.
   - or –
   - Download the standalone CoreAudio driver installer from our website (www.avid.com).

3. Locate and double-click the Install HD Family Driver.mpkg.

4. Follow the on-screen instructions to complete the installation.

5. When the installation is complete, click Restart.

CoreAudio Manager

You can configure the CoreAudio Driver using CoreAudio Manager, or from within most third-party CoreAudio-compatible client applications (such as BIAS Peak or Logic). Refer to the manufacturer’s documentation for more information.

Some applications (such as Apple’s iTunes or QuickTime Player), also require that you configure either the Apple Sound Preferences or Apple Audio MIDI Setup (AMS) to use the CoreAudio Driver.

The CoreAudio Manager is configured to auto-hide when first launched. To bring it to the foreground, click on its icon in the dock.

The CoreAudio Manager is not used by Pro Tools. It is only used by other CoreAudio applications.

Accessing the CoreAudio Manager

The CoreAudio Manager application launches automatically when the first client application accesses the CoreAudio Driver.

CoreAudio Manager (Pro Tools|HD shown)

CoreAudio Manager cannot be accessed under the following circumstances:

- When Pro Tools is running
- When another application is using Direct IO

To ensure proper playback with the CoreAudio Driver, launch the CoreAudio Manager first, making sure that its status is “Connected.”

Preventing an Application from Accessing CoreAudio Driver

You can prevent an application from accessing the CoreAudio Driver by holding down the Shift key just before the application would access the CoreAudio Driver, typically during launch of the application. Certain applications (such as Apple Mail and iChat), do not access the CoreAudio application until they first play a sound, so you will need to hold down the Shift key just prior to sound playback in order to prevent the use of Pro Tools hardware for playback.
Using the CoreAudio Manager

Use CoreAudio Manager to change the CoreAudio Buffer Size setting, access the Hardware Setup dialog for your Pro Tools hardware and control volume and mute for the CoreAudio Driver. CoreAudio Manager also identifies your Pro Tools hardware, the supported number of Input and Output Channels and the number of attached clients (applications).

Buffer Size

You may select from the following buffer sizes (depending on your Pro Tools hardware):

- 64 samples
- 128 samples
- 256 samples
- 512 samples
- 1024 samples
- 2048 samples

Changing the Buffer Size for the CoreAudio Driver does not affect the H/W Buffer Size setting in the Pro Tools Playback Engine dialog.

To configure CoreAudio Hardware Buffer Size:

1. Double-click the CoreAudio Manager file (located in /Applications/Digidesign/).
2. From the Buffer Size pop-up menu, select the desired CoreAudio buffer size (in samples). Generally, smaller buffer sizes are preferable. However, if you experience any problems with performance (such as clicks and pops during recording or playback), try increasing the CoreAudio Buffer Size setting. You can also change the buffer size from within the client application if it is the only client attached to the CoreAudio Driver. Once two or more clients are active, you will not be able to change the sample rate or the buffer size.

HW Setup Button

The HW Setup button opens the Hardware Setup dialog for your Pro Tools hardware. The HW Setup button is only available when no clients are using the CoreAudio Driver.

To configure CoreAudio HW Setup:

1. Quit any CoreAudio client applications.
2. Double-click the Digi CoreAudio Manager file (located in /Applications/Digidesign/).
3. Click the HW Setup button to open the Hardware Setup dialog.
4. Configure the Hardware Setup dialog for your Pro Tools hardware. If you have more than one audio interface connected to a Pro Tools|HD system, be sure to select and configure only the primary audio interface connected to the HD Core card.

For more information on the Hardware Setup dialog, refer to the Pro Tools Reference Guide.

5. When you are finished, click OK to close the Hardware Setup dialog.
**Prefs Button**

The Prefs button opens the CoreAudio Manager Preferences dialog for the Manager application. There are several options available for control and configuration of the Manager application. When finished setting these options, click OK to close the CoreAudio Manager Preferences windows.

![CoreAudio Manager Preferences](image)

**Hide Manager if Auto-Launched by Client** Enable this option to hide the Manager panel after the first client application accesses the CoreAudio Driver. To open the Manager panel, click on the CoreAudio Manager application icon in the Dock.

**Auto-Quit Manager when Last Client Quits** Enable this option to make the Manager application quit when there are no longer any clients using the CoreAudio Driver.

**Use C|24 Stereo Routing (L/R to 1/3)** When using C|24, enable this option to configure the CoreAudio Driver to output through the C|24 standard stereo routing (outputs 1 and 3).

**Use XMON Stereo Routing (L/R to 1/5)** When using D-Control or D-Command, enable this option to configure the CoreAudio Driver to output through the D-Control or D-Command standard stereo routing (outputs 1 and 5).

**Mirror Analog Outs 1 & 2 to Digital Outs (003, 003 Rack, 003 Rack+, Digi 002, or Digi 002 Rack Only)** When using 003, 003 Rack, 003 Rack+, Digi 002, or Digi 002 Rack, enable this option to mirror the main outputs through the digital outputs that are selected in the Hardware Setup dialog. (This option is grayed out for Pro Tools|HD systems.)

**Connect Button**

The Connect button is available when the CoreAudio Manager is launched and cannot connect with the Pro Tools hardware (such as when Pro Tools is launched and the hardware is disconnected or disabled). Before trying to connect, make sure to quit Pro Tools and make sure that your hardware is connected and turned on. You can then click on the Connect button to acquire the hardware.

⚠️ If any application is launched prior to pressing the Connect button and you want that application to use the CoreAudio Driver for playback, you will need to quit and relaunch the application for it to connect properly to the CoreAudio Manager.

**Quit Button**

Use the Quit button to quit the CoreAudio Manager. Be sure to quit any client applications before using the Quit button in the Manager. If any applications are currently attached to the Manager application when quitting, you may get an error message indicating that the Pro Tools hardware is no longer available. You may have to change the application’s preferences to use different hardware for playback or possibly quit and relaunch the application for proper playback to be resumed.
Configuring a Pro Tools|HD Audio Interface for Third-Party Applications

When using a Pro Tools|HD Native with an application other than Pro Tools (such as Apple GarageBand), you can configure hardware settings through the audio preference settings available in that application.

To configure hardware settings through a client application (such as Apple GarageBand):

1. Choose CoreAudio for Audio Output and Audio Input.

2. Select a buffer size for your system by selecting an Optimize For option (Maximum/Large buffer size or Minimum/Small buffer size).

Refer to the documentation for your third-party application to learn more about how these options affect that application.

Configuring the Apple Sound Preferences or Apple Audio MIDI Setup

(Required for Using Qualified Pro Tools System Interface with Apple iTunes or QuickTime Player)

To use your Pro Tools hardware with certain CoreAudio-compatible playback applications (such as Apple iTunes or QuickTime Player), you will need to configure either Sound Preferences or Audio MIDI Setup in addition to CoreAudio Manager. However, for most CoreAudio-compatible client applications (such as BIAS Peak or Ableton Live) this is unnecessary, because you can configure the CoreAudio Buffer Size setting and input and output channels from within the client application.

Apple Sound Preferences

To configure the Apple Sound Preferences:

1. Launch System Preferences (Apple menu > System Preferences).

2. Click Sound.

3. Click Output and select Pro Tools HD Native as the device for sound output.

4. Click Input and select Pro Tools HD Native as the device for sound input.

5. Quit System Preferences.
Apple Audio MIDI Setup

To configure the Apple Audio MIDI Setup:

1. Launch Audio MIDI Setup (located in Home/Applications/Utilities).

2. In the Audio Devices window, click the Input tab.

3. From the Audio Devices list on the left, select Pro Tools|HD Native.

4. In the Audio Devices window, click the Output tab.

5. From the Audio Devices list on the left, select Pro Tools|HD Native.

⚠️ Leave System Output set to Built-in Audio. The CoreAudio Driver cannot be used for system sounds.

6. In the Audio Input or Audio Output page, select the Format (sample rate). Note that the input sample rate and output rate are linked.

💡 For information on configuring MIDI devices in AMS, see the Pro Tools Reference Guide.

7. Choose Audio MIDI Setup > Quit Audio MIDI Setup.
Appendix B

Configuring ASIO (Windows Only)

ASIO Driver Capabilities

The ASIO Driver is a single-client, multichannel sound driver that allows third-party audio programs that support the ASIO Driver standard to record and play back through qualified Pro Tools audio interfaces.

Full-duplex playback of 24- and 16-bit audio are supported at sample rates up to 96 kHz, depending on your Pro Tools hardware and ASIO-client program used (such as Cubase or Reason).

The ASIO Driver provides up to 64 channels of input and output with Pro Tools|HD Native systems.

Visit www.avid.com for the latest ASIO drivers for Pro Tools hardware, as well as current known issues.

Limitations of the ASIO Driver

The ASIO Driver cannot be used with multiple applications at the same time. Only one application at a time can use the ASIO Driver. Be sure to disable the Windows system sounds. It is also recommended that you use a separate sound card for games or other general work.

Installing the ASIO Driver

The ASIO Driver is installed by default when you install Pro Tools. The ASIO Driver can also be installed as a standalone driver on Windows systems that do not have Pro Tools software installed. The installer for the standalone ASIO Driver is available on the Drivers Installer disc that came with your Pro Tools Software package, or from our website (www.avid.com).

⚠️ If you uninstall Pro Tools, the ASIO Driver is automatically uninstalled at that time.

To install the standalone ASIO Driver:

1. Ensure that your Pro Tools|HD Native hardware is correctly installed.

2. Do one of the following:
   - Insert the Driver Installers Disc that came with your Pro Tools Software package in your computer.
   - or –
   - Download the standalone ASIO driver installer from our website (www.avid.com).

3. Locate and double-click the HD Family Driver Setup.exe.

4. Follow the on-screen instructions to complete the installation.

5. When the installation is complete, click Finish to quit the installer and restart your computer.

Visit www.avid.com for the latest ASIO drivers for Pro Tools hardware, as well as current known issues.

If you uninstall Pro Tools, the ASIO Driver is automatically uninstalled at that time.
ASIO Driver Control Panel

Configuring ASIO Driver settings can be done using the ASIO Control Panel, which is accessed within some third-party ASIO-compatible client applications.

Accessing the ASIO Driver Control Panel

To access the ASIO Driver Control Panel from a third-party application:

- Refer to your ASIO-client program’s documentation.

The ASIO Driver Control Panel cannot be accessed under the following circumstances:

- When Pro Tools is running.
- When playing or recording in an audio program that does not support the ASIO Driver.
- When using a third-party audio program that has an option to keep the ASIO Driver open even when you are not playing or recording. (You must close the audio program before you can open the ASIO Driver Control Panel.)

Example with Ableton Live

For example, with Ableton Live, click the Hardware Setup button in the Audio Preferences.

Using the ASIO Driver Control Panel

From the ASIO Driver Control Panel, you can change the Buffer Size setting or access the Hardware Setup dialog for your Pro Tools hardware.
**Buffer Size**

You may select from the following buffer sizes (depending on your Pro Tools hardware):

- 128 samples
- 256 samples
- 512 samples
- 1024 samples
- 2048 samples

- Small buffers have the advantage of low latency in the record monitor path. (Latency is the time delay between a signal entering the audio inputs and leaving the outputs during recording.)

- Larger buffers have the advantage of making the ASIO Driver more immune to audio dropouts during playback and recording.

In some ASIO-compatible audio programs, performing various tasks will interrupt the ASIO Driver and may result in clicks and pops in audio playback or recording. Choosing medium or large buffers (such as 256, 512, or 1024) can help alleviate this problem.

Changing the Buffer Size setting for the ASIO Driver does not affect the H/W Buffer Size settings in the Pro Tools Playback Engine dialog.

**Device**

The Device setting is always set to your installed Pro Tools hardware.

**Advanced Button**

The Advanced button opens the Hardware Setup dialog for the Pro Tools hardware that you are using.

> For more information on the Hardware Setup dialog, refer to the Pro Tools Reference Guide or the User Guide that came with your Pro Tools system.
Low Latency Monitoring

Pro Tools|HD Native systems can use the Low Latency Monitoring option to record with an extremely small amount of monitoring latency, to as many tracks as the system supports. Only tracks with input from an audio interface (not an internal mix bus) use Low Latency Monitoring.

Using Low Latency Monitoring

To use Low Latency Monitoring:

1. From the Output Path selector, assign each track to the selected Low Latency Monitoring Path (as set in the I/O Setup Output page). Only tracks assigned to these outputs use Low Latency Monitoring.

2. Record enable audio tracks by clicking their Record Enable buttons.

3. Select Options > Low Latency Monitoring.

When Low Latency Monitoring is enabled, any plug-ins and sends assigned to record-enabled tracks (routed to the selected Low Latency Monitoring Path) are automatically bypassed, and must remain bypassed. Also, these tracks do not register on meters for Master Faders.
Configuring Low Latency Monitoring in the I/O Setup

The Output page of the I/O Setup lets you enable (or disable) Low Latency Monitoring. It also lets you specify any available Output path for Low Latency Monitoring. The Output path for Low Latency Monitoring can be of any channel width (from Mono to 7.1). Low Latency Monitoring uses Outputs 1–2 by default.

To configure Low Latency Monitoring in the I/O Setup:

1. Open the I/O Setup dialog (Setup > I/O).
2. Click the Output tab.
3. Enable the Low Latency Monitoring option.
4. From the Low Latency Monitoring pop-up menu, select the Output path you want to use for Low Latency Monitoring.
5. Click OK to save your changes and close the I/O Setup.

Low Latency Monitoring and Bounce To Disk

With Low Latency Monitoring enabled, only audio tracks are included with the Bounce to Disk command—Auxiliary Input and Instrument tracks are ignored. To include Auxiliary Input and Instrument tracks, disable Low Latency Monitoring before using Bounce to Disk.

⚠️ External input cannot be recorded during a Bounce to Disk. To include external input in your bounce, it must be recorded to new audio tracks before using Bounce to Disk.
This appendix provides an overview of system mixer delays in Pro Tools|HD Native systems, and explains how you can compensate for these delays for phase coherent time alignment of audio in complex or critical mixing situations.

For detailed information on using Automatic Delay Compensation, see the Pro Tools Reference Guide.

Introduction to System Delay

In all digital systems, digital signal processing (DSP) causes signal delays of varying amounts. These delays can vary from as short as several microseconds to as long as several milliseconds, depending on the type of processing or routing being performed. With Pro Tools|HD Native systems, these delays result from host-based processing tasks.

Do not confuse signal processing-induced delays with monitoring latency or time domain effects processing (such as delay, echo, reverb, and other desirable delay effects).

In addition to delay incurred by the host buffer, each plug-in, hardware insert, and mixer assignment on a track delays that track by an amount equal to the total of all system delay factors. (For more information on these delays, see “Delay Factors” on page 32.)

In some cases, signal processing delays matter only if you use a real-time plug-in on one channel of a stereo or multichannel signal but not the others. This imparts an unequal amount of delay to the signals on that channel, which subsequently may cause undesirable cancellation of certain frequencies (phase cancellation).

Audible symptoms of phase issues include comb-filtering and loss of high frequencies.

In simple terms, system delay can cause audio to arrive at the main output (or a submix output) at different times. To maintain time alignment, you can compensate for these delays.

When to Compensate

You may only really need to compensate for delays between tracks where phase coherency must be maintained (as with instruments recorded with multiple microphones or stereo pairs). If you are working with mono signals, and the accumulated delays are small (just a few samples, for example), you probably do not need to worry about compensating for delays.

However, larger sessions with higher track and voice counts, many plug-ins, and/or complex mixer routing can benefit when system delays are compensated to maintain phase coherent time alignment.
In any session, if you want to maintain absolute time alignment across all tracks you should always compensate for signal processing delays.

---

**Using Delay Compensation**

Pro Tools provides automatic Delay Compensation for managing delays from plug-in and hardware inserts, and mixer routing (bussing and sends). With Delay Compensation enabled, Pro Tools maintains phase coherent time alignment between tracks that have plug-ins with differing DSP delays, tracks with different mixing paths, tracks that are split off and recombined within the mixer, and tracks with hardware inserts.

To maintain phase coherent time alignment, Delay Compensation should always be enabled during playback and mixing. Delay Compensation should also be used in most recording situations.

⚠️ With HD OMNI, Delay Compensation is not supported on Monitor output paths. Delay Compensation is only supported on physical output paths (those not assigned for the Monitor path).

---

**Enabling Delay Compensation**

**To enable Delay Compensation:**

- Select Options > Delay Compensation.

When Delay Compensation is enabled, the Delay Compensation status indicator in the Edit Window Toolbar is displayed.

**Delay Factors**

With Pro Tools, delay is incurred when you perform the following processes:

- Real-time processing with plug-in inserts.
- Mixing and routing with hardware I/O (sends or inserts).

⚠️ For information on the delay amounts for plug-ins, refer to the Audio Plug-Ins Guide.
appendix e

Troubleshooting

Backing Up Your Work

It is highly recommended that you back up your work on a regular basis, and especially before making changes to your system configuration.

Backing Up Your Session Data

Back up your session and audio data frequently. There are a variety of media that are suited to back up projects of various sizes, from automated tape backup systems to high-capacity optical drives, to CD/DVD burners.

The best way to back up an entire session is to use the Save Copy In command. This command lets you save the session file and all of its associated files to a new location.

💡 You can also use the Auto Save Backup feature (in the Operation Preferences page) to have Pro Tools automatically save backups of the session file while you work.

Backing Up Your System Configuration

After configuring your system and Pro Tools, you should save an image of your system drive using a backup utility such as Norton Ghost (Windows) or Bombich Carbon Copy Cloner (Mac). By doing this, you can quickly restore your system configuration and settings if you encounter any problems.
Common Issues

Pro Tools Won’t Launch

Problem
When you double-click the Pro Tools application or a Pro Tools session file, Pro Tools doesn't launch, or displays an error message.

Possible Solutions
- Check to be sure your computer has the required amount of RAM to launch Pro Tools. Refer to our website (www.avid.com).
- Try a complete restart. Turn off your audio interfaces, computer peripherals and your computer, and then turn them on again in the proper sequence.
- If you tried to launch Pro Tools by double-clicking a Pro Tools session file, do the following:
  - Close any error message.
  - Double-click the Pro Tools application.
  - In Pro Tools, choose File > Open Session to open the session.
- Reinstall the Pro Tools application, using the Pro Tools Installer disc.

Audio Interface Is Not Recognized

Problem
When you launch Pro Tools it does not recognize an audio interface, or a connected audio interface is not available.

Possible Solutions
- Turn off your computer and check to be sure your cables are properly and securely connected to your computer and to your audio interface.
- Verify that your Hardware Setup dialog settings are correct.
- If you only have one interface, make sure it is connected to the Accel Core (for PCIe) or HD Core (for PCI) card.
- Make sure Loop Sync, SuperClock or other synchronization connections to your audio interface are correct. Disconnect the clock source from the interface and see if the problem persists.
Using DigiTest as a Diagnostic Tool

The DigiTest utility performs diagnostic tests on the Pro Tools cards in your system. If DigiTest reports that the Pro Tools|HD Native card has failed, click the Info button next to that card. Write down the information that appears and report it to your local dealer or contact Technical Support.

Running DigiTest

DigiTest is installed with Pro Tools and resides in the following folder on your hard drive: Digidesign/Pro Tools/Pro Tools Utilities.

⚠️ Before you run DigiTest, lower the volume of all output devices. Very loud digital noise may be emitted during the test.

For more information on the DigiTest application, see the DigiTest Guide.

To run DigiTest:

1. Quit Pro Tools if it is running.
2. Lower the volume of all output devices on your system.
3. Locate and double-click the DigiTest icon on your hard drive.

DigiTest opens and lists the supported cards it finds in your system, showing their corresponding slot locations.

---

DigiTest main test window

4. Select the card in your system you want to test by selecting Test in the left hand column for the card.
5. Click Run.

If the card is not installed correctly, DigiTest will display an error code in the Status box for the card.

6. When prompted, power cycle all Pro Tools peripherals in your system. Click Continue.

7. To test the interfaces connected to your system, check “Test I/O Box.”

💡 LEDs on your audio interfaces may light up during this test. This is normal.
8 When the test is finished, you can view the test results by doing one of the following:
   • Click the Get Results button next to a card name.
   • Click the Results tab and choose a card slot from the pop-up menu.

9 In the Results page of the DigiTest window, click Show Failures Only to display failed tests for the selected card, or click Show All Results to display all test results for the selected card.

   *For descriptions of error codes, refer to “DigiTest Error Codes” on page 36*

10 Click Quit to close DigiTest.

11 Restart your computer.

**Errors and Undetected Cards**

Complete the steps below if any of the following occur:

- DigiTest fails to launch.
- An error message has been displayed for a card in DigiTest.
- A supported card is installed but not automatically detected during DigiTest.

**If a supported card is installed and is not automatically detected:**

1 Quit DigiTest.
2 Turn off the entire Pro Tools system.
3 Reinstall the Pro Tools|HD Native card.
4 Check the card seating.
5 Turn on the system.
6 Run DigiTest again.

### DigiTest Error Codes

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Err3</td>
<td>Cards from different Pro Tools systems are incorrectly mixed. See the configuration chapters.</td>
</tr>
<tr>
<td>Err4</td>
<td>Cards marked with this error are installed in the wrong order. See the configuration chapters.</td>
</tr>
<tr>
<td>Err5</td>
<td>Too many cards of this type are installed in the system. Refer to the Avid website for compatibility information.</td>
</tr>
<tr>
<td>Err6</td>
<td>A card is installed in a reserve slot. For example, a Pro Tools card is installed in the slot reserved for the Expansion Chassis Host Interface card.</td>
</tr>
<tr>
<td>Err1220</td>
<td>SCSI Accelerator card is installed in the wrong slot. See the configuration chapters for correct location of the card.</td>
</tr>
<tr>
<td>Err1221</td>
<td>Expansion Chassis Host Interface card is installed in the wrong slot (see the Expanded Systems Guide).</td>
</tr>
</tbody>
</table>

**Viewing Card Information with DigiTest**

DigiTest can display identifying information such as serial number, date of manufacture, and firmware ROM version for each card in your system. This information is useful if you need to contact Technical Support about your Pro Tools hardware.
To display information for a card in your system:

1. Quit Pro Tools if it is running.
2. Locate and double-click the DigiTest icon on your hard drive.
3. Click the Slot Info tab.
4. Choose a card slot from the pop-up menu.

**Updating Audio Peripheral Firmware with DigiTest**

If firmware updates are available for any of your Pro Tools|HD audio interfaces (HD I/O, HD OMNI, HD MADI, 192 I/O, 192 Digital I/O, 96 I/O, or 96i I/O), you can use DigiTest to perform the update. Within DigiTest, the Firmware Update page tells you the firmware version for the selected peripheral and lets you update to a newer version, if necessary.

To update the firmware in a Pro Tools|HD audio interface:

1. Quit Pro Tools if it is running.
2. Locate and double-click the DigiTest application on your hard drive.
3. Click the Audio I/O Firmware tab.
4. Select the card slot from the pop-up menu. If any Pro Tools audio interfaces are connected to the card, the Primary or Secondary options become available in the Device Selection section of the Audio I/O Firmware page.

If any connected interfaces are not recognized, check the connections and power to each interface and click Re-Scan.

5. Under Device Selection, select one of the following options for the corresponding connected audio interface and to view the firmware version for the corresponding interface. (The firmware version is displayed just below the Device Selection section of the Firmware page):
   - Connector 1, Primary
   - Connector 1, Secondary
   - Connector 2, Primary
   - Connector 2, Secondary

6. If the firmware version is not current, click Begin Update to update the firmware for the selected audio interface.

   The status of the firmware update process is displayed in the status area at the bottom of the Firmware page.

7. After the update process is complete, click Quit to close DigiTest.
Performance Factors

There are several conditions that may adversely affect the performance of Pro Tools. These include:

**Network Connections** Close any network connections unless you are using them for network interchange of audio data.

**Background Applications** Any software utilities that run in the background or generate disk activity, such as virus protection, disk optimization, or file savers, should be turned off or removed.

**Screen Savers** Screen saver software should be completely disabled on your computer before running Pro Tools.

**Power Saver Features** Some automatic power saver features, such as those that spin down the system hard drive, can affect Pro Tools performance. These features should be turned off.

Gather Important Information

Avid wants to help you resolve problems as quickly and efficiently as possible. If you have the following information handy when you contact Technical Support, it will make the diagnosis of your problem easier. Take a few minutes to collect the following basic information:

System Information

**Computer**
- Make, model, processor speed
- Amount of system RAM
- Operating system (version of Windows or Mac OS)
- Any Drivers, Disk Utilities, or other system-related applications you may have installed

**Pro Tools Hardware**
- Type of cards, interfaces, or peripherals
- Where the cards are installed
- PCI or PCIe card order in computer or chassis
- Interfaces connected to each card

**Hard Drives**
- Make, Model
- Drive size (GB)
- Drive speed (RPM)
- Drive type (SCSI, FireWire, IDE/ATA)
- Utility used to format the drive
- Number and size of partitions on the drive

**Pro Tools Software**
- Pro Tools software version
- Plug-In versions
- Other Pro Tools software options or components
- Additional plug-ins from Avid Development Partners

Before You Call Avid

Register Your System

Register your purchase immediately after reviewing the Registration Information Card included with every Pro Tools system. Registering your purchase is the only way you become eligible to receive complimentary technical support and future upgrade offers. Registering is one of the most important steps to complete as a new user.
**Other Hardware**

Refer to the manufacturer’s documentation for operational details.

The most common hardware additions include:
- 1394 (FireWire) cards for Windows systems (manufacturer, model)
- Expansion Chassis (manufacturer, model, bridge chip type)
- Video Capture cards (manufacturer, model)

To verify that your hardware is qualified for use with your Pro Tools system, refer to our website (www.avid.com).

**Other Software**

If you are using other audio or video applications, refer to the manufacturer’s documentation for operational details.

Make note of any other software that was running when a problem occurred.

**Diagnostic Information**

**DigiTest**

If you run DigiTest, be sure to make a note of any error codes or messages it generates.

**Other Information**

Note any DAE errors or other error codes you encounter. Additionally, note the ability to reproduce the problem under different conditions, for example, with another session, or after changing settings (such as the Hardware Buffer Size).
Appendix f

Compliance Information

Environmental Compliance

Disposal of Waste Equipment by Users in the European Union

This symbol on the product or its packaging indicates that this product must not be disposed of with other waste. Instead, it is your responsibility to dispose of your waste equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste equipment at the time of disposal will help conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more information about where you can drop off your waste equipment for recycling, please contact your local city recycling office or the dealer from whom you purchased the product.

Proposition 65 Warning

⚠️ This product contains chemicals, including lead, known to the State of California to cause cancer and birth defects or other reproductive harm. Wash hands after handling.

Perchlorate Notice

This product may contain a lithium coin battery. The State of California requires the following disclosure statement: “Perchlorate Material – special handling may apply. See www.dtsc.ca.gov/hazardouswaste/perchlorate.”

Recycling Notice
EMC (Electromagnetic Compliance)

Avid declares that this product complies with the following standards regulating emissions and immunity:
- FCC Part 15 Class A
- EN55103-1 E4
- EN55103-2 E4
- AS/NZS CISPR 22 Class A

FCC Compliance for United States

Radio and Television Interference

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules.

DECLARATION OF CONFORMITY

We, Avid, 75 Network Drive
Burlington, MA 01803, USA
650-731-6300
declare under our sole responsibility that the product
Pro Tools|HD Native
complies with Part 15 of FCC Rules.
Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and
(2) this device must accept any interference received,
including interference that may cause undesired operation.

Communication Statement

NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try and correct the interference by one or more of the following measures:
- Reorient or locate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.
Any modifications to the unit, unless expressly approved by Avid, could void the user’s authority to operate the equipment.

Argentina Conformity

Australia and New Zealand EMC Regulations

Canadian Compliance

This Class A digital apparatus complies with Canadian ICES-003
Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada

Korean EMC Regulations

Taiwan EMC Regulations
European Union Declaration of Conformity

(EMC and Safety)

Avid is authorized to apply the CE (Conformité Europénne) mark on this compliant equipment thereby declaring conformity to EMC Directive 2004/108/EC and Low Voltage Directive 2006/95/EC.

Safety Compliance

Safety Statement

This equipment has been tested to comply with USA and Canadian safety certification in accordance with the specifications of UL Standards: UL60065 7th /IEC 60065 7th and Canadian CAN/CSA C22.2 No. 60065-2003 /A1:2006. Avid Inc., has been authorized to apply the appropriate UL & CUL mark on its compliant equipment.

Warning

Important Safety Instructions

1) Read these instructions.
2) Keep these instructions.
3) Heed all warnings.
4) Follow all instructions.
5) Do not use this equipment near water.
6) Clean only with dry cloth.
7) Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.
8) Do not install near any heat sources such as radiators, heat registers, stoves, or other equipment (including amplifiers) that produce heat.
9) Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two blades and a third grounding prong. The wide blade or the third prong are provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.
10) Protect power cords from being walked on or pinched particularly at plugs, convenience receptacles, and the point where they exit from the equipment.
11) Only use attachments/accessories specified by the manufacturer.
12) For products that are not rack-mountable: Use only with a cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the equipment. When a cart is used, use caution when moving the cart/equipment combination to avoid injury from tip-over.
13) Unplug this equipment during lightning storms or when unused for long periods of time.
14) Refer all servicing to qualified service personnel. Servicing is required when the equipment has been damaged in any way, such as power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the equipment, the equipment has been exposed to rain or moisture, does not operate normally, or has been dropped.
15) For products that are a Mains powered device:
The equipment shall not be exposed to dripping or splashing and no objects filled with liquids (such as vases) shall be placed on the equipment.

Warning! To reduce the risk of fire or electric shock, do not expose this equipment to rain or moisture.

16) For products containing a lithium battery:
CAUTION! Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type.

17) The equipment shall be used at a maximum ambient temperature of 40° C.

18) Use only with Listed ITE equipment.
האימונים לתכני הבישות

הערה בטיחות

מכשירים זה בני דיכאון חשמלי רגישים בבישותי ולא אולתרו בריח.

בנהאמה למסירת פטריוטי על צוותם של Avid Inc. .Canadian CAN/CSA C22.2 60065-3

CUL| UL 1-60065 7th/IEC 60065 7th

אזהרה

CAUTION
RISK OF ELECTRIC SHOCK

DO NOT OPEN

האימונים בשירות החובשים

(1) שיגוריאו את החובשים.
(2) שsembler את החובשים במתקנים במחושב.
(3) ש.getCmpמן את החובשים.
(4) ש المتعلים באיתור החובשים.
(5) שבלשון במתקנים בשירות החובשים.
(6) שבלשון במתקנים בשירות החובשים.
(7) שבלשון במתקנים בשירות החובשים.
(8) שבלשון במתקנים בשירות החובשים.

אזהרה

CAUTION
RISK OF ELECTRIC SHOCK

DO NOT OPEN

Pro Tools|HD Native User Guide
Numerics
192 Digital I/O 11
192 I/O 10
96 I/O 11
96i I/O 12

A
ASIO Control Panel 26
ASIO driver (Windows) 25
capabilities 25
control panel 26
installing 25
limitations 25
audio drivers
ASIO driver (Windows) 25
CoreAudio driver (Mac) 19
audio interfaces 7
connecting 16
firmware (Windows) 37
HD I/O 8
HD MADI 9
HD OMNI 7
heat and ventilation 18
Pro Tools|HD 7
automatic delay compensation 32
Avid website 4

C
cables
DigiLink 6
DigiLink Mini 6
compatibility 2
CoreAudio driver (Mac) 19
capabilities 19
CoreAudio Manager 20
installing 19
CoreAudio Manager 20

D
Delay Compensation 32
enabling 32
DigiLink
cable lengths 6
cables 6
DigiLink Mini
adapter cable 6
cable lengths 6
cables 6
DigiLink Mini ports 5
DigiLink to DigiLink Mini adapter cables 6
DigiSerial port 5
DigiTest 35
troubleshooting 36
drives
requirements 3
DSP delays 31
automatic delay compensation 32

E
error codes
DigiTest 36
EUCON-compatible controllers 12

F
firmware
audio interfaces (Windows) 37

H
hard drives
requirements 3
HD I/O 8
Analog Expansion cards 8
analog I/O 8
configurations 8
Digital Expansion cards 8
Digital I/O 9
synchronization 9
HD MADI 9
HD OMNI 7
  analog I/O 7
digital I/O 7
  features 7
  monitoring 8
  synchronization 8

I
I/O Setup
  Low Latency Monitoring 30
installation
    Pro Tools|HD Native card (Mac) 14
    Pro Tools|HD Native card (Windows) 15

L
Loop Sync
  connecting 17
low latency monitoring
    Bounce to Disk 30
    Low Latency Monitoring option 29
    Low Latency Monitoring path 30

M
MIDI
  supported interfaces 3

O
Operations menu
  Low Latency Monitoring option 29
Options menu
  Delay Compensation option 32

P
phase 31
Pro Tools
  capabilities 2
Pro Tools|HD Native card
  installation (Windows) 15
  installing (Mac) 14
  Pro Tools|HD Native PCIe card 5

R
registration information 3

S
sample delays 31
screen savers 38
SYNC peripheral
  DigiSerial port 5
system requirements 2

T
time alignment 31

W
www.avid.com 4